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Introduction

Google Slides is a web-based application for creating presentations similar to Microsoft PowerPoint, available with a
free Google account. You can create and edit presentations using your web browser or the mobile app. In addition to
presentations you create, you can also edit and convert PowerPoint presentations. Slides files are accessible through

Google Drive and the Google Slides homepage.

Creating and Importing Files

You can create new presentations by starting a blank presentation, using a template from the gallery, or uploading

and converting an existing file.
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To create a blank presentation from Google Slides:
1. Sign into https://slides.google.com

2. Click the tile for Blank at the top of the page
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To create a presentation from a template in Google Slides:

1. Use the arrows in the top right corner to expand the template gallery

2. Choose your category

3. Select the template you need
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To create a presentation from Google Drive:

1. Sign into https://drive.google.com

. Click the New button in the top left corner

2
3. Choose Google Slides
4
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. Use the arrow over to select Blank presentation or From a template
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To convert a PowerPoint file from Google Drive:
1. Signinto https://drive.google.com

2. Click on the New button in the top left corner

3. Choose File upload
4

Select the PowerPoint file on your computer and click Open

bl

Right click on the uploaded file (or double click to open)
6. Choose Open with and select Google Slides if it does not open in Slides automatically

7. Convert your PowerPoint file to Google Slides by selecting File from the menu, then clicking on Save as Google
Slides.
a. This creates a new file

Accessing Your Files

You may want to open presentations you have previously created or need to continue editing. You can access your
files from either Google Slides or Google Drive.
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To access a file from Google Slides:
1. Organize your files
a. Choose grid view or list view
b. Sort files by name, last modified date, or last opened date

c. Filter files by ownership

2. Choose the presentation you want to open

3. Ifyou can't find the file you need, search for it with the file picker or search bar at the top of the page
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To access a file from Google Drive:
1. Organize your files
a. Folders will appear first, followed by files
b. Sort files by name, last modified date, or last opened date

c. Sortfiles ascending or descending

2. Choose the presentation you want to open
a. Suggested files will appear in the top menu

b. Recent files can be accessed from the left side menu

c. Starred files (files marked as important) can be accessed from the left side menu
3. Ifyou can't find the file you need, search for files in the Drive search bar at the top of the page
Navigation

Within a presentation, you can navigate from the main screen, menu toolbar, and shortcuts toolbar. The slide pane lets
you view and edit a selected slide.
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1. Placeholders show where you can click to add information

2. Speaker notes pane lets you add notes for use when presenting (not viewed as part of the presentation)

The top left of the screen includes basic navigation tools.
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1. Return to Google Slides from the icon in the top left corner
2. View the presentation name in the top left corner

3. Staricon adds your file to your starred files; folder and cloud syncing icons will appear to the right for
presentations that are named or included content

4. Menu toolbar shows various drop-down menus with commands and options
5. Shortcuts toolbar shows shortcut buttons for commonly used features and commands

6. Slide navigation pane shows previews of your slides

The top right of the screen includes presenting and sharing options.
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1. Commenticon lets you easily view and manage comments
2. Present options let you play completed presentations for an audience and access presentation tools

3. Share options let you share your file for collaboration with other users

The drop-down menus on the menu toolbar group similar commands and options.

*  File menu: Includes options for email, downloads and page setup

e Edit menu: Includes editing commands like copy, paste and undo

W Plano
fublic PLANOLIBRARY.ORG

9
o Ty


http://planolibrary.org

Q‘ Google Slides: Basic Info

* View menu: Includes options related to how items appear on screen while working
e Insert menu: Includes commands to add components like images, audio and video to your presentation
e Format menu: Includes commands to adjust how text appears, like bulleted lists

e Slide menu: Includes commands for managing slides, including duplicating, changing layout and applying
transitions

* Arrange menu: Includes commands for arranging individual elements on your slides
» Tools menu: Includes tools like spelling and grammar check

e Add-ons: Allows access to any add-ons installed on your account

» Help: Accesses Google's help information and keyboard shortcuts

Themes and Personalization
Themes include colors, fonts and slide layouts that give a consistent look and feel to your presentation.
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1. Click on Theme in the shortcuts toolbar

2. Scroll through the available options and choose your theme

3. Ifyou don't see a theme you like, import a theme from an existing presentation by selecting Import theme

Use the theme builder to apply changes to any slide with that layout in your presentation.
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1. Click on the View menu

2. Choose Theme builder

3. Choose the slide layout you want to change

4. Make your changes with the shortcuts toolbar

5. Click the white X to close the theme builder and return to the slide pane

Slides and Layouts
Many slide layouts include placeholders to show where text will appear. Choose from different slide layouts,
depending on your content.
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1. Toinsert a new slide and change the layout:

2. Choose an option to insert a new slide:
a. Choose the Slide menu and select New slide
b. Use the plus sign in the shortcuts toolbar
¢. Use the keyboard shortcut CTRL + M

3. Select the desired slide to change its layout
4, Choose your desired layout
a. From the Slide menu:
» Choose the Slide menu
e Choose Apply layout
» Choose the layout you need
b. From the shortcuts toolbar
* Select Layout

» Choose the layout you need

5. Asyou create slides, you may need to organize or rearrange them. Duplicate slides to make exact copies, delete
slides you no longer need, or reorganize your slide order

To duplicate a slide from the menu:
Select the slide you want to duplicate

Choose the Slide menu

v o N o

Choose Duplicate slide

10. To duplicate a slide from a right click:

11. Select the slide you want to duplicate

12. Right click

13. Choose Duplicate slide

14. To delete a slide, choose one of the following:

15. Select the slide you want to delete, choose the Slide menu, and choose Delete slide
16. Select the slide you want to delete, right click, and choose Delete

17. Select the slide you want to delete and hit backspace or delete on your keyboard

18. To reorder slide, you can drag and drop them from either the film strip view or the grid view. To move multiple
slides, press CTRL while clicking on them
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Adding Content
1. You can add text, images, shapes, charts, diagrams, audio and video to your slides

2. Many slide layouts include placeholder boxes to add text
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Click to add text

Click to add speaker notes

Click in the placeholder box to add text.

Use the shortcuts toolbar to change font size, color, or style

Use the sizing handles (points) around placeholder boxes to resize

Click on the box to grab it, then drag and drop placeholder boxes to rearrange them on the slide

When the text box is selected, use the icon with two lines and an arrow to resize text on overflow

Insert additional text boxes from the shortcuts toolbar or Insert menu

Click in the box underneath the slide to add speaker notes
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To insert an image from the menu:
1. SelectInsert

2. Choose Image

3. Choose your image source

4, Navigate to or select your image

5. Choose Insert

To insert an image from the shortcuts toolbar:

1. Click on the image icon
2. Choose your image source
3. Navigate to our select your image

4. Choose Insert

Insert Format Slide Arrange Tools Add-ons Help

[& Image >
Text box

<) Audio
i M Video
@ Shape »
Table -
l [& chart -
- Diagram
A Word art
g . Line >

) Special characters

i & Animation
@2 Link Ctri+K
i Comment Cirl+Alt+M
New slide Ctrl+M
1 Slide numbers
[

To insert a shape from the menu:
1. Select Insert
Choose Shape

2
3. Choose your shape category
4

Choose your specific shape

5. Click and draw the shape on your slide
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To insert a shape from the shortcuts toolbar:
1. Click on the shapesicon

2. Choose your shape category

3. Choose your specific shape
4

Click and draw the shape on your slide

Points scored

To insert a chart:
1. Select Insert
Choose Chart

Choose the type of chart you need

> W N

Modify your chart in Google Sheets by clicking the link icon in the top right corner to access the source

b

Resize the chart by using the handles

6. Move the chart by dragging and dropping
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insert a diagram:

Select Insert

Choose Diagram

Choose the type of diagram you need
Choose the number of steps and your color
Choose the layout

Edit content by clicking on the placeholders
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Format options

“  Audio playback

Start playing

@® oOnclick

(O Automatically
Options

Volume when presenting

Hide icon when presenting

[J Loop audio

Stop on slide change

»  Size & Rotation
» Position

» Recolor

»  Adjustments

»  Drop shadow

» Reflection

To insert audio:

1. SelectInsert

2. Choose Audio

3. Navigate to the audio you want to include
4. Choose select

5. Adjust options with the format options menu
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Insert video x

Search By URL Google Drive

D YouTube S

Type your search in the box above to find videos.

To insert video:

1. SelectInsert

2. Choose Video

3. Choose your video source

4. Navigate to your video and choose Select

5. Adjust options with the format options menu

Transitions and Animations
Transitions and animations can help make presentations more dynamic and engaging. Transitions refer to how an
entire slide behaves. Animations refer to how individual items on the slide behave.

Motion X

Slide Transition

AV D Fade

Fade -

Slow Medium Fast

Apply to all slides

Object Animations

Play
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To insert a transition:

1.

2
3.
4

To
1.

2
3.
4
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Choose Slide, then Transition or click Transition on the shortcuts menu
Choose the slide transition you want

Choose the speed of your transition by moving the slider

Choose whether to apply the transition to all slides

Click Play to preview your transition

Object Animations

v ™" Appear (On click) |
Appear -
On click -

By paragraph

Medium Fast

]
o

> ™' Flyin from left (On click)

Add animation

Play

insert an animation:

Choose Slide, then Transition or click Transition on the shortcuts menu
Select the item on the slide you want to animate (text box, image, etc.)
Under Object Animations, choose Add animation

Choose the animation you want

Choose when the animation should occur

Choose whether to break up blocks of text, if needed

Choose Play to preview your animation

PLANOLIBRARY.ORG
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8. Drag and drop from the list to reorder animations, if needed

9. Use the trash can icon to delete animations, if needed

Presenting
Presenting is how you share slides and content with others during presentations, meetings and other settings.

To present, choose one of the following:

* Click Present in the top right corner of your screen
* Select View, then choose Present

e Click CTRL + F5

Your slide show will open in full screen for others to view. Navigate by clicking the mouse, using your keyboard or
using the menu bar at the bottom of the screen.

Presenter tools include your speaker notes, a timer and audience question and answer. To access these tools, click on
the arrow next to Present in the top right corner of your screen and select Presenter view.

W‘(. Presenter view - Sweet Treats Year End Rexiew - Google Slides - Google Chrome - o x ‘

| @ aboutblank |

00:00:18 Pause Reset AUDIENCETOOLS ~ SPEAKER NOTES ‘

slide 1 =

MAAANANANNANANNNANANANANNNNAS

* e - !
Q Jweet Treats
*

Next

Just click to present

Start new

1. The timer can be used the check the timing of your presentation; pause and reset it at any time
The slide pane shows your current slide

Use the Next pane to preview upcoming content

> W N

Use Start new to start an audience Q & A session. Questions will appear in the Audience Tools window for you to
manage as they are submitted

5. Use Speaker Notes to see any notes you have associated with the slide
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Organizing Your Files
If you'd like to organize your files into folders or make copies of presentations, you will need to use your Google Drive
homepage or be in the presentation.

To copy a file:

1. From within the presentation:
a. Select File, then Make a copy

o

Choose if you want to copy the entire presentation or selected slides
Name the copy of your presentation

Choose a location to save it

Choose whether to keep your sharing features and any comments
Click Ok to finalize

-~ o o n

2. From Google Drive:
a. Select the file you want to copy

b. Right click and choose Make a copy

To rename afile:
1. From within the presentation:
a. Clickin the file name box in the top left corner

b. Make the desired changes and click out of the box or press Enter to save

2. From Google Drive:
a. Select the file you want to rename

b. Right click and choose Rename

¢. Make the desired changes and click OK

To move afile:
1. From within the presentation:
a. Click on the folder icon in the top left corner next to the file name
b. Select the location to move your file to
c. Toaccess subfolders, click on the arrow icon next to the main folder name
d. Click Move here

2. From Google Drive:
a. Select the file you would like to move

b. Choose an option to move your file:
» Drag and drop the file into the appropriate folder
* Right click on the file and choose Move to
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To delete a file:
1. Right click on the file you would like to remove and choose Delete

2. Allfiles in your trash are deleted forever after thirty days

To restore a file:
1. SelectTrash from the menu on the left side
2. Find the file you would like to restore

3. Rightclick and choose Restore

To restore a previous version of a file:
1. Select File, then Version history

2. Select See version history

3. To preview a past version, click on it

4. To restore that version, click Restore this version

Printing and Downloading
Since Google Slides saves as you work, you will always have access to the most current copy of your presentation
online. You can also download, print or email your presentation.

Before printing, you will need to choose your print settings.

kground  Include skipped siides  Download as PF ¢ Print

Test Slide 1

Page 1 I 4 | — @& +

1. SelectFile
Choose Print settings and preview

Choose your slide layout, which includes notes and the number of slides per page

> W N

Select your page orientation, if needed
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5. Choose whether to show or hide slide backgrounds

6. Choose whether to include any skipped slides

From this window, you can download your presentation as a PDF, print the file or close your preview.

To print your presentation:

1. From the menu:
a. Choose File, then Print

b. View your document in the preview and adjust print options if needed

¢. Select your printer and print settings

2. From the shortcuts toolbar:
a. Select the printericon

b. View your document int the preview and adjust print settings if needed

¢. Select your printer and print settings

To download your presentation:
1. Choose File, then Download

2. Choose the appropriate file type

To email your presentation:

1. Choose File, then Email

2. Choose Email this file

3. Enter the email you would like to share the presentation with
4

Enter a subject line and message

bl

Choose the file type for sending your presentation
6. Choose whether or not to send yourself a copy

7. Click Send
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Collaborating and Sharing

Sharing your presentation gives you different options for collaborating with others and gathering feedback.
To share your presentation:

1. Click File, then Share or use the yellow Share button in the top right corner
a. Choose whether to share your document by email or link and enter the appropriate information

e Share with people and groups o]

@ Jaime Eastman X Editor ~

W4 Notify people
o Fi=T Viewer

Message
Commenter

+ Editor

Send feedback to Google Cancel m

To share by email:
1. Enter the email addresses for your collaborators

2. Choose your permissions
a. Viewers can view your document but cannot make changes
b. Commenters can add comments but cannot make changes

¢. Editors can make full changes

3. Add a personal message, if desired

4. Click Send
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@ Share with people and groups

No one has been added yet

@ Get link

https://docs.google.com/document/d/1cRSv6DwbM4EFyuBemvgKiERKINL... Copy link

Anyone with the link ~
Anyone on the internet with this link can view

Viewer =

" Viewer

Send feedback i Google

Commenter

Editor

To share by link:
Copy the link to your presentation

Choose your permissions:
Restricted links work only for people you have added as collaborators
Anyone links work for anyone who has the link

Click Done

Comments allow you to suggest changes, ask questions and interact with other collaborators
1. From the comment history icon:

a. Click n the comment history icon in the top right corner

b. Click on Add a comment

c. Type your comment, then click Comment

2. From the shortcuts menu:
a. Click on the commenticon

b. Type your comment, then click Comment

3. From the menu:
a. Choose Insert, then Comment

b. Type your comment, then click Comment

4. From the slide:
a. Highlight the desired text or select the desired placeholder

b. Right click, then choose Comment
c. Type your comment, then click Comment
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Jaime Eastman o
0 2:46 PM Sep 7
Test comment 1 Edit

Delete

Link to this comment...

To mange your comments:

1. Click on the comment

2. Reply by typing in the box underneath the comment
3. Use the check mark to mark a comment as resolved

4. Use the three dotes to access additional options, like editing, deleting or linking to your comment

Common Keyboard Shortcuts
Many tasks in Google Docs can be completed with keyboard shortcuts. You can access additional shortcuts through
the Help menu.

Keyboard Shortcut Outcome

CTRL+B Bolds the selected text
CTRL+C Copies the selected text
CTRL+D Duplicates the selected slide or object
CTRL +1 Italicizes the selected text
CTRL+M Adds a new slide

CTRL+P Opens the print menu
CTRL+U Underlines the selected text
CTRL+V Pastes the copied text
CTRL+ X Cuts the selected text
CTRL+Y Redoes the previous action
CTRL+Z Undoes the previous action

Additional Information

Explore additional resources on our website and blog Plano Library Learns, including information about library
databases. Use your Plano Public Library card to access LinkedIn Learning and Learning Express Library for online
tutorials.

Books

Google Drive & Docs in 30 Minutes: The Unofficial Google Apps
Guide to Google Docs, Sheets & Slides by Luke Johnson
by lan Lamont Checkout
Checkout
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Additional Resources
Access additional learning resources and tutorials through LinkedIn Learning. For additional help, explore the Google
Workspace Learning Center.

Google Slides Essential Training with Jess Stratton Link
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